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EpiGraph: an open-source platform to quantify 1	  

epithelial organization. 2	  

 3	  

Supplemental Information. 4	  

 5	  

SUPPLEMENTAL EXPERIMENTAL PROCEDURES 6	  

EpiGraph Source code. 7	  

The project’s code is accessible through Github 8	  

https://github.com/ComplexOrganizationOfLivingMatter/Epigraph. It is open 9	  

source and available under GPLv3 license. 10	  

Pipeline.  11	  

The image processing pipeline entails cells recognition, valid cells 12	  

identification, graph of cell-cell contact creation, polygon distribution analysis 13	  

and, finally, GDDH, GDDRV and GDDV5 calculation. These stages are properly 14	  

described on the subsequent paragraphs. 15	  

- Recognition of existing cells 16	  

EpiGraph uses as input segmented images from natural tissues or 17	  

simulations. These images must be built in binary format, where one colour 18	  

should be presented as the background, forming the body of cells, and the other 19	  

one the cells outline. Each cell gets assigned a label using MorphoLibJ 20	  

(Legland et al., 2016). This identifier will allow us to have a record of every cell 21	  

and his location on the image that it will be necessary for the following steps. 22	  

- Valid cells identification 23	  

Once we have properly labelled the image, we proceeded to fully analyse it. 24	  

By default, an invalid region is created. This region is initially defined by the 25	  

boundaries of the image itself. We got all the cells that fall into these borders 26	  

and set them as no valid cells. In this way, we avoid an incorrect 27	  

characterization of polygon distribution due to the lack of real neighbours in the 28	  
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margins of the image. However, you can add a personalized invalid region 1	  

selecting as many cells as you want. 2	  

In addition, we define another two kinds of valid cells: the 4’ valid cells and the 3	  

5’ valid cells. The former represents the cells that do not have a not valid cell 4	  

within a distance of four cells connexions. The later kind is formed by the cells 5	  

having all valid cells in a maximum length of five cells connexions. Mo7 and 6	  

Mo10 require 4’ valid cells and Mo17 and Mo29 5’ valid cells. 7	  

- Neighbourhood creation  8	  

An epithelium can also be seen as a tessellation because there’s no space 9	  

between each cell.  Thus, inspecting the number of sides of the cells we can 10	  

measure the number of neighbours that will surround it. We, therefore, extend a 11	  

mask from each pixel of the cell with a given shape and size, both selected by 12	  

the user. Then, we capture all the cells distinct from the actual cell that fall into 13	  

this mask and add them as neighbours of the concrete cell. Afterwards, we 14	  

create a neighbourhood network, modeling each cell as a node and connecting 15	  

two cells with an edge, if they are neighbours. 16	  

- Polygon distribution analysis 17	  

The polygon distribution is defined by the number of sides of every valid cell. 18	  

We specify three different areas: the global zone formed by all valid cells, the 19	  

region in which 4’ valid cells are contained and the territory in which 5’ valid 20	  

cells are placed. For Mo7 and Mo10, we use a path of length 4 (4’ valid cells as 21	  

orbits nodes, and valid cells as its branching nodes), and for Mo17 and Mo29 22	  

the area is defined by the cells contained within the path of length 5 (5’ valid 23	  

cells as orbits nodes, and valid cells as its branching nodes). Finally, we 24	  

calculate the polygon distribution regarding the cells involved in the graphlet 25	  

calculation. 26	  

- GDDH, GDDRV and GDDV5 calculation 27	  

We have adapted Graphlet degree Distribution agreement Distance (GDD) 28	  

from Yaveroğlu et al. (Yaveroğlu et al., 2014) to fully integrate it with FIJI java 29	  

environment. We use GDD to compare two images getting how similar or 30	  

dissimilar they are. In particular, minimum distance value (0) means two images 31	  
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are equal, and maximum distance value (1) specifies that they are very different 1	  

in terms of graphlets. We compute all the graphlets in which the valid cells 2	  

participate. Then, we use only the graphlets in which 4’ or 5’ valid cells are 3	  

included (depending on the set used). We defined three references to compare 4	  

with the real images. The first one is Graphlet degree Distribution agreement 5	  

Distance Random Voronoi (GDDRV). A random Voronoi (RV) is generated from 6	  

500 random points establishing related Voronoi cells. Then, we computed the 7	  

distance between twenty RV images and the real image getting only the mean 8	  

of these twenty distances as final reference. We also calculated Graphlet 9	  

degree Distribution agreement Distance Hexagons (GDDH), which measure the 10	  

different between a given image and a regular tessellation of hexagons, in a 11	  

similar way than GDDRV. And, finally, we computed the Graphlet degree 12	  

Distribution agreement Distance Voronoi 5 (GDDV5) by comparing a given 13	  

image with twenty diagrams 5 from the CVT path and getting its mean. 14	  

A full set of tutorials explaining how to install and use EpiGraph is available at 15	  

EpiGraph’s wiki (https://imagej.net/EpiGraph). In addition, Movie S1 16	  

summarizes a general example with default options. 17	  

Graphical user interface. 18	  

ImageJ’s distribution FIJI (Schindelin et al., 2015, 2012) provides a framework 19	  

which offers a range of functions and a suitable predefined application 20	  

programming interface (API). Furthermore, it allows users without programming 21	  

expertise to execute and exploit all their functionalities. EpiGraph is prepared for 22	  

heavy processes. On these cases, some operations such as “calculate 23	  

graphlets”, perform on background giving the user the possibility of move 24	  

around the application smoothly. Besides, a progress bar displays the evolution 25	  

of the task in case it could take longer than expected. FIJI works on the three 26	  

main Operative Systems (Linux, Mac and Windows) without even require Java 27	  

installation since it is usually embedded in the program. FIJI describes different 28	  

ways to be operated by external software. One of them is constructing a plugin, 29	  

which is used by EpiGraph as basic structure to start building. Using Java 30	  



	  
4	  

Swing GUI libraries, we have designed the three windows of the EpiGraph 1	  

plugin.  2	  

- Main Window 3	  

The program starts after clicking on Plugins>EpiGraph. The first window that 4	  

appears is the Main Window. It contains a table of processed images (therefore, 5	  

initially it is empty). Graphlets calculated data could be instantiated into a table 6	  

that is organized by columns. A table’s row is composed by these columns: 7	  

Colour, label, GDDH, GDDRV, GDDV5, percentage of hexagons, radius of 8	  

shape, type of shape, kind of graphlet calculation and the selection of the 9	  

graphlets results. Colour column lets you pick the colour of the point from the 10	  

palette to be visualized later; Label shows the name of each image data; 11	  

GDDH, GDDRV and GDDV5 represent the GDD of the image against 12	  

hexagons, random Voronoi diagrams and Voronoi 5 diagrams from CVTn, 13	  

respectively; Percentage of hexagons contains as his graphlet name said, 14	  

proportion of hexagons for all cells involved in graphlet calculation; Radius 15	  

specify the shape’s size used to calculate neighbours; Shape characterizes the 16	  

type of form used to calculate neighbourhood; Kind of calculation displays which 17	  

set of graphlets was used. Finally, Select column lets you by means of a check 18	  

box, the possibility of visualizing or not the calculated data in a 3D viewer, and 19	  

in the same way, remove the selected rows if you click on the button remove 20	  

rows. Additionally, you do not need to calculate every single time the graphlets 21	  

properties, you can import your own dataset properly formatted from an Excel 22	  

file, using import table button. Likewise, once you have already analysed 23	  

several images, you could export your information into an Excel file, using the 24	  

export table button. In addition of exporting the data contained into the table, as 25	  

tip, you export the polygon distribution of the cells involved in the graphlets 26	  

calculation. Lastly, you have the option of representing all table’s rows, in which 27	  

visualizing check box was typed as true. For that, you should click on visualize 28	  

button to launch the mentioned 3D viewer. 29	  
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- Image processing Window 1	  

This window will be automatically triggered when a supported file format was 2	  

correctly selected, after click over the open main window button. This window is 3	  

composed by a button panel with different processing options, a canvas with the 4	  

loaded image embedded in it and a polygon distribution legend. The only 5	  

enabled button when the window just opened will be the mode in which you 6	  

label the image. You can choose labelling this image considering 8 connectivity 7	  

or 4 connectivity and then, click on label image button to execute it. After that, 8	  

other buttons become enabled. These buttons are classified in 3 panels:  9	  

• Region of interest. The main objective of this panel was selecting regions 10	  

of interest to only process valid regions and discard the invalid ones. 11	  

create ROI and select cells buttons let you select various rectangular 12	  

(default) regions and picking cell by cell respectively using the FIJI’s ROI 13	  

manager tool. You could combine repeatedly both options to establish a 14	  

valid region in which operating. In addition, you might modify the ROI 15	  

selection shape from rectangular to another one, using FIJI’s control 16	  

panel. On the other hand, we had the option to choose an invalid region 17	  

by picking over it, after clicking add invalid regions button. This action 18	  

only lets you store a set of invalid ROIs at a time, so if you wanted to add 19	  

an invalid region after saving previous invalid regions, you will delete the 20	  

former to include a new one. 21	  

• Neighbourhood. It lets you the possibility of visualizing valid and no valid 22	  

cells, invalid regions and polygon distribution values from the current 23	  

image. To calculate the neighbourhood you should select, using the 24	  

number picker (located close to radius), a size of shape in pixels and a 25	  

specific geometrical shape using the picker above (located next to 26	  

shape). This selection depends on the wide of the cells outline, you could 27	  

only choose between circular or square shape, but using any size of 28	  

pixels. When the parameters have been selected, test neighbours button 29	  

can be pressed to calculate the neighbourhood for the valid cells 30	  

belonging to the ROI. If the ROI is the whole image, a column next to the 31	  

legend of polygons shapes, headed by “Graphlets”, would be filled with 32	  
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the polygon distributions of the valid cells. Otherwise, if the ROI is a 1	  

subsection of the image, the cited column would be filled with the 2	  

polygon distribution of the all valid cells participating in the ROI graphlets 3	  

calculation. In addition, a new column appears next to “Graphlets” 4	  

headed by “ROIs” that would be filled by the polygon distribution of the 5	  

valid cells belonging to this ROI. 6	  

In general, the legend will be completed with the proportion of polygons 7	  

and an overlay would be displayed over the canvas, representing the 8	  

type of polygons with a specific colour.  9	  

In addition, toggle overlay button lets you visualize or not the overlay 10	  

created by test neighbours. Black colour labels the invalid regions and 11	  

the cells outlines at the overlay, dark grey marks no valid cells, and the 12	  

rest of colours (represented in the polygon distribution legend) are 13	  

reserved for valid cells. It is important to highlight that the intense colours 14	  

of the legend displayed over the canvas represent the number of sides of 15	  

the valid cells into the ROI. The same pale colours represent the polygon 16	  

distribution of valid cells located out of the ROI affecting to the graphlet 17	  

calculation. 18	  

Graphlets. This panel is designed with the aim of saving graphlets data 19	  

internally and externally. There is a write section where you can add the 20	  

data label (image name by default), located after image label text. As 21	  

well, you can select a colour label for our data, using pick a colour button. 22	  

Finally, you choose the appropriated method to calculate graphlets data. 23	  

The options are: ’26 graphlets (Mo29)’ (default), ‘17 graphlets (Mo17)’, ‘9 24	  

graphlets (Mo10)’ and ‘7 graphlets (Mo7)’. As soon as the method has 25	  

been selected, you can continue clicking calculate graphlets data button 26	  

to acquire data of calculated graphlets. Once this process has 27	  

successfully finished, data are automatically added on the main window 28	  

table. Furthermore, clicking over Export Graphlet data you can export a 29	  

ZIP file containing: a JPG image representing the neighbourhood, 30	  

another JPG image capturing the label of the cells, a CSV file storing all 31	  
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calculated graphlets data and a .sif that represent the neighbourhood 1	  

network. 2	  

This window has a progress bar that estimates the process state. As a tip, you 3	  

can modify the image zoom by pressing control and rotating the mouse wheel at 4	  

same time. 5	  

- Visualizing Window 6	  

We count with a 3d viewer to display our calculated results stored in the main 7	  

window’s table. When a row´s checkbox is ticked, it will be plotted. To develop 8	  

this window, we have used an open source library named Jzy3D 9	  

(http://www.jzy3d.org/) that is able to create different graphical representations. 10	  

In particular, we make use of the 3d scatter plot class. 11	  

 This window will be displayed after click over visualize button (located in the 12	  

main window), even if your table is still empty. This window is composed by the 13	  

scatter plot figure located at left and a set of components to modify the 14	  

appearance of this figure at rigth. The plotted figure is delimited by a 3D box 15	  

with 3 axes: Percentage of hexagons, GDDH and GDDRV by default. These 3 16	  

axes can be replaced by any of the following configurations (X-Y-Z axes) using 17	  

the drop-down list with the label Axes of figure (upper right corner of the 18	  

window): 19	  

1- GDDH-GDDRV-Percentage of hexagons (default) 20	  

2- GDDH-GDDRV-GDDV5 21	  

3- GDDH-GDDV5-Percentage of hexagons 22	  

4- GDDRV-GDDV5-Percentage of hexagons 23	  

The Percentage of hexagons axis encapsulate values between 0 – 100, and 24	  

the others between 0 – 1. These limits can be modified for zooming the 25	  

individual axes. We used 3 rangeSliders to choose the range for each axis to be 26	  

represented due to the limitations of the Jzy3D library. This library only provides 27	  

you the possibility of zooming the Z axis turning the mouse wheel. You can 28	  

visualize the three rangeSliders (one per axis) just below the Axes of figure 29	  

drop-down list. 30	  
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Into the scatter plot you can observe by default our CVTn path, displayed as 1	  

individual dots: The darkest dot, represents the average of first iterations in 2	  

CVTn and the lightest one the average of last iterations of CVTn. You have the 3	  

option to disable the visualization of these references clicking on the checkbox 4	  

‘Show reference’ (just below of rangeSliders), to only display calculated data. 5	  

Besides, it is available the adjustment of the size of the dots modifying the 6	  

position for slider bar, just located down the mentioned checkbox. 7	  

Distinguishing the different modes in which graphlets data of CVTn reference 8	  

can be calculated, a drop-down list can be deploy clicking over the label Motifs 9	  

of CVTn reference. This list, let you the possibility of representing CVTn path 10	  

depending on the method in with graphlets are calculated: Mo29, Mo17 (by 11	  

default), Mo10 and Mo7. We also have defined four possible combinations of 12	  

graphlets that can be computed by EpiGraph: 26 graphlets representing 29 13	  

cellular motifs (Mo29), 17 graphlets that represent 17 cellular motifs (Mo17), 9 14	  

graphlets on behalf of 10 cellular motifs (Mo10) and 7 cellular motifs represent 15	  

by 7 graphlets (Mo7). Mo7 and Mo10 are formed by graphlets of maximum 4 16	  

nodes, while Mo17 and Mo29 make use of graphlets of maximum 5 nodes. Mo7 17	  

and Mo10 are very useful when images have a small number of cells, since 18	  

both require a less number of cells than Mo29 and Mo17. 19	  

The dots showed in figure from the Main Window can be modified changing 20	  

the colour box in the Main Window’s table. In addition, a .png figure screenshot 21	  

can be saved, pressing Export view button. For more detail, different angles and 22	  

modes of visualization are available. For instance: clicking the figure and 23	  

moving the mouse will turn the vision angle, and double clicking on the figure 24	  

will automatically perform a 360 degrees’ rotation. 25	  

Functionalities. 26	  

Along the program execution process, we will have the capability of developing 27	  

a set of functionalities: 28	  

- Label image 29	  

Once you have selected an image to process, this image is binarized and the 30	  

background is analysed to consider what is the cells colour and outlines colour. 31	  

If the number of white pixels is higher than black pixels, white pixels will be 32	  
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considered as cell’s body, and vice versa. After that, each cell’s body region of 1	  

the image is assigned with a unique label. Thanks to the extensible architecture 2	  

of FIJI, in which you can install plugins to add additional functionalities, this 3	  

process of labelling regions is made using MorphoLibJ (Legland et al., 2016) 4	  

funcionalities. Specifically, using the connected component labelling that 5	  

transforms a binary image into a labelled one by assigning a specific number to 6	  

each connected component. 7	  

- Testing neighbours 8	  

As mention on previous section, EpiGraph is able to calculate the polygon 9	  

distribution with a given pixel radius and an element’s shape. To ensure that the 10	  

neighbourhood is correctly captured, we empower the users to verify if the 11	  

image has the right parameters by themselves. The polygon distribution of the 12	  

image will appear with numbers at the left side of the window and, also, painting 13	  

each cell with a colour representing its number of sides. As well, dark grey 14	  

almost black will represent no valid cells. Depending on the number of graphlets 15	  

you’d like to see, the affected zone will be established by a group of cells or 16	  

another. These internal calculations for neighbourhood will be exploited by 17	  

calculate graphlets module, while parameters are not modified since this step. 18	  

- Create ROI 19	  

Though you may analyse the image as it comes, you could also process only a 20	  

region of interest (ROI). Through FIJI’s Roi Manager we can manage the ROIs, 21	  

saving and doing operations between each other. Nevertheless, we have only 22	  

selected as default operations within EpiGraph: rectangle (or any available 23	  

shape) and multipoint selection. The former creates a rectangle selection (by 24	  

default) and adds all the cells that fall inside it as valid cells. The latter, enables 25	  

the multipoint function and it lets select individual cells. Yet, you might want to 26	  

change these default form of selection, going straight to FIJI’s main window and 27	  

pick any of the toolbar. 28	  

-Pick invalid regions 29	  

Owing to your image may present artefacts as false valid cells, we provide the 30	  

possibility to mark these zones as invalid region. All valid cells surrounding the 31	  

mentioned invalid region will be considered as “no valid cells”. On this behalf, it 32	  
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is possible select, with the multipoint tool, several areas of the image to make 1	  

them over into invalid sections. To validate this action, picked invalid region 2	  

should have the same colour than cells’ background. 3	  

- Calculate graphlets 4	  

The main course of EpiGraph is the graphlet comparison. It is supposed to be 5	  

the final step of the algorithm and pipeline. It begins checking if there are any 6	  

selected cells or ROIs. Then, in case any configuration has changed, we re-7	  

compute the neighbourhood, otherwise we take the information from a previous 8	  

computation. From this neighbourhood and valid cells, it calculates the 9	  

graphlets for the involved network of neighbours. As mentioned on previous 10	  

sections, it would be incoherent not to filter the graphlets, so we refine it by 11	  

adding to the final graphlets only the nodes with a fixed distance to the border 12	  

nodes. We first calculate the total set of graphlets for valid cells, and then, we 13	  

select a filtering that depends on the chosen type of Graphlets to be implicated: 14	  

Mo29 (26 graphlets), Mo17 (17 graphlets), Mo10 (9 graphlets) and Mo7 (7 15	  

graphlets).  The involved orbits nodes for graphlets calculations will be referred 16	  

as 4’ and 5’ valid cells. When we have the final graphlets, we calculate the three 17	  

distances (GDDH, GDDRV and GDDV5). Depending on the number of 18	  

graphlets selected, a variable number of orbits are used on the comparison. At 19	  

last, the results will be added automatically to the table on Main Window.  20	  

- Visualization 21	  

Visualizing results properly is a major feature and an important challenge to 22	  

interpret results. Thus, we have embedded Jzy3d chart in a Java’s JDialog 23	  

where you can visualize the calculated results three coordinates (any 24	  

combination of GDDH, GDDRV, GDDV5 and percentage of hexagons) as a 25	  

point in a scatter plot. Once the points are represented you can compare them 26	  

with our CVTn reference. On this behalf, you may want to change the illustrated 27	  

CVTn selecting the number of graphlets used on the computations, although it 28	  

is advisable to compare images with the same configuration (Mo7, Mo10, Mo17 29	  

or Mo29). Additionally, there is a possibility of increasing or decreasing the size 30	  
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of the dots and zoom manually each axis. Finally, you can export the actual 1	  

view of the chart to an image file. 2	  

Dependencies. 3	  

FIJI is designed to add functionalities via several ways, one of them is Plugin. 4	  

In order to have a simple control of dependencies and project settings, it uses 5	  

Maven. Maven is a tool that is broadly used for supervising and build Java-6	  

based projects. It integrates several tools, such as Javadoc, to make easy all 7	  

the programming steps. Likewise, dependencies are downloaded and updated 8	  

when available. Furthermore, it helps you create the package with all your code 9	  

and zip it in a .jar file that will be the Plugin format of FIJI.  All this is achieved 10	  

through its project object model (POM), which you can shape to your project 11	  

adding mailing list, issue tracking and more. 12	  

Supported file formats. 13	  

EpiGraph’s input is an image. This image should be properly segmented and 14	  

grey-scale, still, there are several options within EpiGraph to configure it 15	  

depending on the type of the image. We allow images with different size of 16	  

borders, since it can be permitted to increase the radius of the mask, changing 17	  

the way in which neighbourhood is built. We make no distinction between colour 18	  

depth, supporting images from 8-bit to 32-bit. However, it is mandatory that 19	  

images have to be binary images, where one colour is presented as the 20	  

background, forming the body of cells, and the other one the cells outline. 21	  

Regarding the image file extensions, we entrust FIJI the image opening and the 22	  

supported files as well, so individual image file extensions allowed by FIJI would 23	  

be supported in EpiGraph. We cannot admit any sequence of images and single 24	  

images with high resolution due to problems with complexity in EpiGraph 25	  

processing tasks. Accordingly, we limit the maximum of 3000px to either height 26	  

or width of the image, for a correct execution of the program. 27	  

Quick step-by-step EpiGraph’s usage. 28	  
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- Installation 1	  

Through FIJI/ImageJ update site: 2	  

The usual way to install a FIJI plugin is through his on-site updater. It’s usually 3	  

located on “Help > Update FIJI”. Once, it’s open, you click on “Manage updates 4	  

sites”, look for EpiGraph and tick the checkbox next to it. Finally, “Apply 5	  

changes” and you should have successfully installed this plugin. With this 6	  

option, you can automatically get the latest version of EpiGraph. 7	  

Manually: 8	  

On the other hand, you may just want to download the .jar file from 9	  

http://tinyurl.com/EpiGraph-PlugIn (or even generate your own .jar from source 10	  

code) and install it manually. On this purpose, you could click either 11	  

Plugins>Install or Plugins>Install PlugIn. So, you select the provided .jar and 12	  

you should be able to run EpiGraph. 13	  

- Simple example of a complete analysis 14	  

Calculate GDDH, GDDRV, GDDV5 and percentage of hexagons from a given 15	  

image and visualize it in the 3D visualizer.  16	  

1. Select open. 17	  

a. Select a supported image. 18	  

b. If the image is correct, a window with the image will appear. 19	  

2. Pick connectivity: 20	  

a. Select the connectivity of your image. Usually 8-connectivity. 21	  

b. Press label. 22	  

3. Default configuration: 23	  

a. Radius of 3 pixels. 24	  

b. Circle shape. 25	  

4. Calculate graphlets: 26	  

a. Write a name for your image. 27	  

b. Pick a colour for your image. 28	  

c. Select in the combo box to Mo29 (26 graphlets). 29	  

d. Press calculate graphlets. This will calculate GDDH, GDDRV and 30	  

GDDV5. 31	  
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e. Once it is finished, if name box is not empty, data would be added 1	  

to the main window’s table. 2	  

5. Export graphlets data: 3	  

a. EpiGraph create a zip with several files. Obtains an image with all 4	  

the cells labelled with their corresponding identifier. Another image 5	  

representing the polygon distribution and, finally, a ‘.csv’ file with 6	  

the graphlets for all the cells. 7	  

b. Press the Export graphlets data button. 8	  

6. Visualize your results: 9	  

a. Return to the main window. 10	  

b. Click on visualize. 11	  

7. Export view: 12	  

a. Staying at the visualizing window, you always have the option of 13	  

exporting the actual view into a ‘.png’ file. 14	  

b. Press export view. 15	  

Congratulations! You have done the complete pipeline. Now, check where is 16	  

your image regarding the CVTn scale. You should analyse whether or not your 17	  

image is near the CVTn (reference). 18	  

- Create region of interest 19	  

In the case you would like to test a given region of your images, you can 20	  

create a region of interest (ROI). We already have an image opened and 21	  

labelled within EpiGraph. 22	  

1. On the image processing window: 23	  

a. Press Create ROI. 24	  

b. Although, the default ROI is square shaped, you may want to test 25	  

another shape. You can now return to FIJI application and select 26	  

any of the existing ones on the toolbar. 27	  

c. Click done. Your ROI is managed and stored in FIJI Roi Manager. 28	  

You have already created your ROI, nonetheless, you cannot see how affect it 29	  

to the image yet.  30	  

2. Press Testing neighbours: 31	  
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a. An image representing each cell by its number of 1	  

neighbours will appear as overlay in your image. Remember that 2	  

the valid cells into the ROI, appear with intense colour, and the 3	  

pale colours represent the rest of valid cells that affect the 4	  

computation of graphlets. These cells will also be represented in 5	  

the polygon distribution legend. 6	  

 7	  

Once this procedure has been accomplished, you could continue the 8	  

execution in the same way than before: graphlet calculation, exportation of 9	  

results and visualization. 10	  

- Combine ROIs 11	  

Since regions of interest are managed by the ROI manager you could add 12	  

several ROIs to the image. You have already opened the image and properly 13	  

labelled. 14	  

1. Press Create Roi: 15	  

a. Select a left region. You should not select any of the cells on the 16	  

right yet. 17	  

b. Done. 18	  

2. Select individual cells: 19	  

a. Click Select cells. 20	  

b. Pick only cells on the right. 21	  

3. Test your setup: 22	  

a. You should be able to see the cells inside that fall into both ROIs. 23	  

b. Press test neighbours. 24	  

4. Oh! You realize you have made a mistake: 25	  

a. You do not want the first ROI. 26	  

b. Go to the ROI manager. 27	  

c. Select the first ROI and click Delete. 28	  

5. Test the new selection: 29	  

a. You now will represent only the existing ROI on the right. 30	  

b. Click test neighbours again. 31	  
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If you create some ROIs, the select cells will be all the cells that fall into any of 1	  

the ROIs. The logical operation would be an OR, so ROIs could be disjoint. 2	  

- Selection of the number of motifs 3	  

There are 4 possible configurations, now we will be creating an analysis with 4	  

Mo17 using only 17 graphlets. 5	  

1. Open an image with only 4-connected elements and borders with 3 or 6	  

more pixels (for a different example). 7	  

2. Label it: 8	  

a. Select now 4-connectivity. 9	  

b. Click label. 10	  

3. Test if neighbours are correct: 11	  

a. Since you do not know what the radius pixels you should select, 12	  

test various shapes and radius in order to see if the cells with 6 13	  

neighbours are really 6-sided cells. 14	  

b. Change parameters and click on test neighbours to make sure the 15	  

neighbourhood is fine. 16	  

4. Mo17: 17	  

a. With this configuration, we have seen that there are no strange 18	  

‘jumps’ between iterations of CVTn, so you will be able to see a 19	  

trustable result. 20	  

b. Hold in the combo box the default option, Mo17 (17 graphlets). 21	  

5. Calculate graphlets: 22	  

a. Add a proper name to your image. 23	  

b. Press calculate graphlets to add results to the table. 24	  

6. Visualizing: 25	  

a. Change the colour of your row to a pink-ish colour. This will let you 26	  

differentiate your data from the reference, which is black, grey and 27	  

almost white. 28	  

b. Click on Visualize. 29	  

c. At default, your reference is Mo17 (17 graphlets). So, preserve 30	  

this option in the combo box. 31	  

d. Modify the axes of figure to ‘GDDH-GDDRV-GDDV5’. 32	  
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e. Change the range sliders at your right side to get an adjusted 1	  

visualization per axis. 2	  

You will see that the reference has changed and your image is probably 3	  

alienated to the CVTn reference. This is because your image is within the CVTn 4	  

path, otherwise the image organization would be different to our model of 5	  

reference.  6	  

- Import/export table 7	  

You may want to save your results somehow, to achieve this, you might export 8	  

your results to an excel file. As simple as pressing the button export in the main 9	  

window.  10	  

On the other hand, if you would like to continue your session right where you 11	  

left, you could import your exported excel file to the table and carry on with your 12	  

analysis. You can add as many .xls files to the table as you want, we allow 13	  

duplicates. If you want to remove them, just tick them at the Select all column 14	  

and click on Delete rows. 15	  

Troubleshooting 16	  

If the visualization is not working properly, you may need to update FIJI after 17	  

the installation. 18	  

If you find something weird with any functionality of the application, you can 19	  

send a e-mail to pvicente1@us.es or pgomez-ibis@us.es. Reporting bugs can 20	  

also be made through Github 21	  

https://github.com/ComplexOrganizationOfLivingMatter/Epigraph/issues. Known 22	  

issues are held at the same page. 23	  

 24	  

License Information. 25	  

To encourage the sharing of resources, EpiGraph is published under an 26	  

open-source (GPLv3) license, which can be downloaded from 27	  

https://github.com/ComplexOrganizationOfLivingMatter/Epigraph/blob/master/LI28	  

CENSE. 29	  

 30	  

 31	  
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SUPPLEMENTAL FIGURES 1	  
 2	  
Figure S1. Graphlets and orbits configuration. Illustration of graphlets 3	  

networks used in (Pržulj, 2007). Each graphlet configuration is labelled with Gn, 4	  

in which, ‘n’ is the graphlets number (from G0 to G29). These labels match with 5	  

the cellular motifs in (Fig. 1). Each vertex represents a cell and each edge the 6	  

connection between two cells. Therefore, the graphs represent the connectivity 7	  

network for each matched cellular motif. The three graphlets labelled in red 8	  

(G20, G22 and G25) are the ones discarded in our work. The digits (from 0 to 72) 9	  

into some mauve vertices indicate the orbits number counted for the GDD 10	  

calculation.  11	  

  12	  
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Figure S2. Pipeline for the Graphlet degree Distribution agreement 1	  

Distance  (GDD) calculation. Scheme representing the protocol sequence to 2	  

calculate the GDD between two segmented images: Eye and Diagram 1. First, a 3	  

network of cells-to-cells contacts is computed defining the centroids of valid 4	  

cells as nodes and its connections with neighbouring cells as edges. The nodes 5	  

are represented with the same colour code as in Fig. 2. Second, the graphlets 6	  

are extracted from the network. This enables the calculation of an index of the 7	  

distribution of every graphlet. Finally, a comparison between the two Graphlet 8	  

degree Distributions is performed to obtain the GDD value.   9	  

  10	  
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Figure S3. Epithelial organization of biological tissues with respect CVT. 1	  

A-D) Same configurations as (Fig. 2D-G) for Mo17 of GDDH, GDDRV, GDDV5 2	  

and percentage hexagons, but using CVT path instead of CVTn. The diagrams 3	  

of the CVT started with iteration 1 and finished with iteration 700. CVT is 4	  

represented as a grayscale gradient from black, reducing its darkness with the 5	  

increase of the iterations. 6	  

  7	  
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Figure S4. Extra combinations for Mo17: CVTn, mutants and simulations. 1	  

A-D) Several GDD combinations (A: Percentage of hexagons vs GDDV5; B: 2	  

GDDH vs GDDV5; C: Percentage of hexagons vs GDDRV; D: GDDH vs 3	  

GDDRV) using Mo17 for CVTn, Eye, cNT, dWL, dWP, CVTw1 and CVTw2, 4	  

represented exactly as (Fig. 3 B-C). E-H) Values of the percentage of hexagons 5	  

vs GDDV5 (Mo17) (E), GDDH vs GDDV5 (F), percentage of hexagons vs 6	  

GDDH (G) and GDDH vs GDDRV (H) for CVTn, Eye, cNT, dWL, dWP, Control, 7	  

Case III and Case IV. These graph complement (Fig. 3 H-I). 8	  

  9	  
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LEGENDS OF SUPPLEMENTAL FILES  1	  

Movie S1.  A general example of the usage of EpiGraph. The movie shows 2	  

how to add the data of a new image using default options. 3	  

 4	  
Table S1. GDD values between pair of images from natural images and 5	  

Voronoi Diagrams. Graphlet degree Distribution agreement Distance mean 6	  

between each row and column is shown. Data is divided by the used cellular 7	  

motifs (Mo17 and Mo29). The used samples are Voronoi 1, 4 and 5: 20 8	  

replicates; dWP: 16 replicates; dWL: 15 replicates; Eye: 3 replicates. 9	  

 10	  

Table S2. GDDs and percentage of hexagons of CVTn reference using all 11	  

the cellular motifs sets. Data are distributed depending on the cellular motifs 12	  

used (Mo7, Mo10, Mo17, Mo29). Mean and standard deviation of percentage of 13	  

hexagons, GDDH, GDDRV and GDDV5 are shown, along with their associated 14	  

diagram. 20 replicates of each diagram are represented. 15	  

 16	  
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